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 Introduction 
 
Use this guide as your go-to support resource for troubleshooting and diagnosing common issues related to 
End-Users, Application Server, and the SQL Server.  The intended audience for this guide is System & Network 
Administrators, as well as your Database Administrator.  
 
Note: Studio Enterprise is in a phased End-Of-Life Support Cycle.  Please refer to our EOL Phased Support Cycle 
for further details. 
 
This guide is not meant to replace your IT team that manages your Studio Enterprise Environment, but as a 
support resource to aid in troubleshooting and maintaining a healthy and functional Studio Enterprise 
Environment. 
 
These are resources to use in conjunction with this guide: 

• Studio Enterprise Installation and Configuration Guide 

• Studio Enterprise Compatibility Reference 

• Best Practices for Bluebeam Studio and Studio Enterprise 

• SQL 2016 database installation and migration: Guidance and best practices 

 
To ensure you have and are maintaining a healthy environment, refer to the sections Maintaining a Healthy 
Environment to ensure your environment meets all recommendations and Environmental Checks to ensure 
your environment is setup for optimal performance. 
 
If your Studio Enterprise environment or End-Users experience any issues after verifying the above 
environmental checks, then our General Troubleshooting section should help resolve most common issues. 
This section includes Studio Outage - General Steps for Resolution for troubleshooting steps and 
recommendations related to a general outage where users are unable to connect. 
 
For the purposes of this document, the term “Studio Server” refers to the machine that Studio Enterprise is 
being installed on. The Studio Enterprise Server may also be referred to as “SE” or the “App Server”. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://support.bluebeam.com/articles/studio-enterprise-eol-announcement/
https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
https://support.bluebeam.com/articles/compatibility-studio-enterprise/
https://support.bluebeam.com/articles/best-practices-for-bluebeam-studio/
https://support.bluebeam.com/articles/sql-db-guidance-best-practices/
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 Maintaining a Healthy Environment 
 

System Requirements, Recommendations, and Best Practices 
 

Ensure all System and Hardware requirements from the Studio Enterprise Installation and Configuration Guide are 
followed. These are strict requirements. If they are not met Studio Enterprise will likely exhibit undesired behavior and 
not work as designed. 
 

Minimum Server CPU and RAM Recommendations 
 

These recommendations depend on several factors and are not guaranteed to fit every environment. Factors such as the 
number of connected users, the number of requests + traffic to/from the server, types of activity occurring, size of files 
and markups, etc. all have an effect on performance.  

 
As a general recommendation, 2 Processors and 16GB RAM is a good starting point for the Studio Enterprise application 
server, and at least 2 processors with 16-32GB of RAM for the SQL database server. 

Total Registered users, 20% concurrent 1,000 users 2,000 users 4,000 users 6,000 users 8,000 users 

App Server CPU 4 CPU 6 CPU 8 CPU 10 CPU 12 CPU 

App Server RAM 16 GB RAM 24 GB RAM 32 GB RAM 40 GB RAM 48 GB RAM 

SQL Server CPU 4 CPU 6 CPU 8 CPU 10 CPU 12 CPU 

SQL Server RAM 32 GB RAM 48 GB RAM 64 GB RAM 80 GB RAM 96 GB RAM 

 
As a general recommendation, scale up servers by 2 CPU and 8 GB RAM.  These recommendations are assuming the 
following are considered. 

• Dedicated Servers 
o Ensure that SQL Server is being used solely for Studio Enterprise 
o Studio Enterprise and Microsoft SQL Server are installed on separate servers 

• Data transfer speeds between Studio Enterprise and SQL servers are adequate 
• SQL Instance setup to Microsoft's recommendations 

• At least 1 Gigabit connection between SQL and Application server 
 

Studio Enterprise Server Recommendations  
• See our SQL database migration and installation: Guidance and best practices for database recommendations 

and suggestions. 
• Must meet Studio Enterprise Compatibility OS & Hardware Requirements 

o Studio Enterprise Installation and Configuration Guide 
o Studio Enterprise Compatibility Reference 

• Disable Windows Search Indexing  

o By default, Windows Server has Windows Indexing disabled. However, Windows Search Indexing is 
enabled by default. Studio Server manages project files within the Windows file system, and any 
creations or updates of project files while it is enabled will invoke the Windows Search Indexer to 
create or update file metadata. 

• Use System Storage (C: volume) with high IOPS physical drive  
o When a file is posted to a ASP.NET application, the files are temporarily stored, by default, on the C: 

volume. Performance of the drive will impact upload performance. Files beyond a defined threshold are 

https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
https://support.bluebeam.com/articles/sql-db-guidance-best-practices/
https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
https://support.bluebeam.com/articles/compatibility-studio-enterprise/
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stored within the local file system instead of memory. Uploaded PDF files will easily surpass the 
predefined, default 256KB threshold. 

• Ensure disk capacity does not Surpass 87.5% (NTFS formatted drives only)  
o By default, Windows volumes are formatted with NTFS. Behind the scenes, NTFS utilizes a Master File 

Table (MFT) to string together the file directory tree along with metadata such as creation and update 
dates. NTFS will reserve 12.5% of the volume to be used by the MFT to store that information. If 
utilization fills up, the MFT and new file data will be in contention for the remaining space. 

• Consider using a higher performing CPU and memory profile to improve performance 

 

SQL Server Recommendations 
 

• Ensure you have a Database Administrator (DBA) assist in setting up the SQL environment and configure it for 
best practices. 

• Must meet Studio Enterprise Compatibility OS & Hardware Requirements. 
o Studio Enterprise Installation and Configuration Guide 
o Studio Enterprise Compatibility Reference 

o At this point, we recommend a dedicated Microsoft SQL 2016 Server for Studio Enterprise. SQL Server 
Express can only be used for testing, so Standard or Enterprise Editions are recommended.  

• Use a Dedicated SQL instance. 
o Ensure the SQL Server is being used solely for Studio Enterprise. 
o Studio Enterprise and Microsoft SQL Server must be installed on separate servers. 

• Ensure Studio database is set to grow unlimited and at minimum 1GB growth rate. 

• Re-index to mitigate any performance degradation. Try to keep fragmentation below 15%. 

• Ensure Studio database is on a "non-system Storage" (external) high IOPS physical drive. 

• Continually monitor disk space to ensure the database is not reaching maximum drive capacity. 

• Consider using a higher performing CPU and memory profile to improve performance. 

• If needed, run the “exec sp_updatestats” command on both databases, during off-peak hours, to reduce 
latency. 

• Ensure regular database maintenance is setup to maintain database health. SQL maintenance is to ensure that 
Database keeps on performing optimally. These are standard database practices not specific to Studio 
Enterprise that should be performed by your DBA. Our recommendations are: 

o Backup – Full Backup of All Databases (daily) 
o Backup - Transaction Logs (every 15 minutes) 
o Check database integrity (daily) 

o Reorganize index (daily) 
o Update statistics (daily) 
o Rebuild index (weekly) - It’s best to keep fragmentation below 15% if possible. 

 

Environmental Checks 
 
Below are different things to investigate when you experience Studio Enterprise Issues or for ensuring you are running a 
healthy/optimized environment. 
 

General 
• Ensure Application and SQL server meets all requirements 

o Studio Enterprise Compatibility Reference 
o SQL 2016 is recommended (express is not supported for Production)  

• Check network bandwidth and usage. Are there issues if you switch to another network? 

https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
https://support.bluebeam.com/articles/compatibility-studio-enterprise/
https://support.bluebeam.com/articles/sql-db-guidance-best-practices/
https://support.bluebeam.com/articles/compatibility-studio-enterprise/
https://support.bluebeam.com/articles/sql-db-guidance-best-practices/
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• Check CPU/RAM usage on the Studio Enterprise Server & SQL Servers. 

• Test to determine what specifically is slow (connecting, Session upload/download, Project 
upload/download/check-out), test on multiple Revu client systems. 

o Are Sessions working as they should? Are Projects working properly? 

• Have there been any SQL, AD, Studio Enterprise server, certificates, etc. changes around the time you started 
receiving reports of the issue? If so, investigate those changes or roll them back if needed. 

• When users sign into Studio do users checking the "Use Windows Authentication" box, domain/user, or using an 
email address? 

• Verify App and SQL server resources are sufficient. 

• Verify available disk space on both the App server and SQL server. Especially that the SQL database is not full 
and is free to grow. 

o The database & translation log may become full, and as a result there is no more space to write to the 
DB. This can cause serious issues. 

• What version of Revu clients are being used? SE 3.1 supports Revu 2015 – Revu 20. 

• Check for pending Windows Updates on the servers. 

• Perform a Data Transfer Test. 
 

Studio Enterprise (Application) Server 
• On the Studio Application Server, please ensure the Microsoft Message Queuing (MSMQ), Bluebeam Studio Job 

Queue, and Bluebeam Studio Services are all running. 

• Check Studio Enterprise Administrator > Status > and verify if there is an IP address in the Hostname field?  
o If so, change to the Servers FQDN. You will need to restart the server for the change to take effect.  

• Ensure the portal is accessible and can an admin login?  
o To open the portal, enter the server name in a web browser.  

▪ Example: https://bluebeam.[company].com  
o In the Control Panel page can you verify that Bluebeam Studio Service and Bluebeam Job Queue are 

running? 
o Note: Ensure you are using an https URL. Http will not work properly. 

• Ensure at least .NET 4.5 is installed and in a healthy state.  
o Reinstall or repair .NET if you suspect issue. 
o You can run a Microsoft .NET Framework Repair Tool to see if there are any errors in the .NET 

configuration on the App server. The repair tool can be found here. 

• Ensure IIS version meets compatibility requirements and is running in a healthy state. 
o Check IIS to ensure site is running and app pool is running.  
o Perform an IISRESET from an elevated command prompt if there’s an issue. 

 

SQL Server 
• Verify if the BluebeamCache database exist on the SQL server. 

• Verify SQL is running and test the connection to the SQL server via the Bluebeam Studio Enterprise 
Administrator console. 

o Open the SQL Server Configuration Manger on the SQL Server and ensure the SQL Server service is 
running and has the correct service account. 

o "Windows Authentication" checkbox requires SE 3.1 and Revu 2015 or newer. 

• Ensure there are Studio Database maintenance jobs setup to be run on a regular basis.  
o This includes back up, defrag, and re-indexing jobs.  
o These should be setup by the DBA. 

 
 
 

https://www.microsoft.com/en-us/download/details.aspx?id=30135
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General Troubleshooting  
 

Studio Outage - General Steps for Resolution 
 
These are general error resolution steps. These steps can be used for a variety of different issues and will in many cases 
either help resolve the issue or rule out a number of possible causes.  

If the issue is specific to a single user, clearing their cache or resetting settings may resolve the issue for the user. In this 
case, reference this article to reset settings and reference the Clearing Session/Project Cache sections on this document 
to clear cache. If the issue is affecting all users, look into below steps.  

• Follow steps found in the following support article.  
o https://support.bluebeam.com/articles/troubleshooting-studio-enterprise-performance-issues/  

• Test the connection to the Studio Enterprise Server from another Revu client. Make note if this is user specific. 
• Test the connection to the SQL server via the Database Connection tab in the Bluebeam Studio Enterprise 

Administrator console on the App server. 
• The following steps can be completed to help try to resolve the issues. These steps will re-cycle the Bluebeam 

Studio application and hopefully correct possible issues with the SQL server. Ensure the servers in question have 
valid recent backups.  

o Restart the SQL Server 
o Restart the Studio Enterprise Application Server 
o Restart IIS (Internet Information Services) on the Application Server (via command line as an admin by 

entering the following: iisreset /restart) 
o Restart the Bluebeam Services from the Studio Enterprise Administrator application (Tools > Restart 

Server) - You may need to run this restart twice. 
▪ On the Studio Application Server, please ensure the Microsoft Message Queuing (MSMQ), 

Bluebeam Studio Job Queue, and Bluebeam Studio Service are all running. 
o WARNING: Restarting the Bluebeam Services will cause a momentary loss of connection for active 

users. Restarting the server or any Bluebeam Services should be done in a maintenance window to avoid 
downtime for the users. Revu has an Offline mode that will allow them to continue working while the 
services restart, but as a best practice we recommend performing any disruptive changes during non-
business hours. 

• Check the Studio Enterprise Portal in a web browser. Are you able to login?  
o Ensure “https” is used rather than “http”. 

• If these steps do not help, investigate the logs (details below) and correlate issues to possible 
Problem/Solutions found in this package. 

• Read through above Environmental Checks section and ensure they are followed. 

 

Log Files 
 
In troubleshooting issues in a Studio Enterprise environment, the associated logs will be a valuable resource. Here are 
details on where the logs can be found and what to expect. As Studio Enterprise has advanced in its EOL phase, 
Bluebeam Support cannot assist with reviewing these log files. Please use them with your Studio Server administrative 
team to help in issue resolution. 

Log File Locations 
• Studio Enterprise Logs 

o Bluebeam Studio Enterprise Administrator Application > File > Show Logs 

https://support.bluebeam.com/articles/how-to-back-up-your-revu-2019-settings-stamps/
https://support.bluebeam.com/articles/troubleshooting-studio-enterprise-performance-issues/
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o Default Location: C:\Windows\Temp\Bluebeam Software 
o Also Check: 

▪ C:\Users\[ServiceAccount]\AppData\Local\Temp\Bluebeam Software (aka %temp%)  
▪ Location of the Bluebeam Studio Administrator log 
▪ You can check what Service Account is via Database in administrator 

▪ C:\Windows\ServiceProfiles\NetworkService\AppData\Local\Temp\Bluebeam Software  
• Studio Enterprise Install logs  

o C:\Users\[account]\AppData\Local\Temp  
o Look for logs starting with “Bluebeam_Studio_” 

• Check Event Viewer (Application & System) logs for errors 
1. Click on Start in the bottom left of Windows. 
2. Type in Event Viewer and hit Enter. 
3. In the Event Viewer, double click on Windows Logs on the left. 
4. Check both Application Logs and System Logs for errors. 

• Don't forget to also investigate the Revu client logs. Investigating the most recent Revu.log will usually supply 
needed context. 

o These can be found in the Revu (2018) or Logging (2015-2017) tab of the Bluebeam Administrator or in 
Revu’s Preferences (Ctrl+K) > Admin for Revu 2019 and above. 

 
NOTE: In all logs created by Revu, the most recent entries will be found at the bottom of the log.  
 

Log Contents 
• ActiveDirectoryAdminPortal  

o AD related issues while in the Studio Portal. E.G. LDAP Configuration 
o Not Revu connection issues 

• AutoMapReport  

o AD Automapping 
• Discovery  

o Related to Revu clients making request to "discover" the other endpoints (Portal, SignalR, etc) in Studio 
• HTTPService  

o For the iPad app. Communication and errors related to Revu/Vu iPad can be found here. 

• JobQueue  
o Emails, other non-realtime processes 
o Project and Session Purge Service 

• Portal  
o Errors that occur while in the Studio Portal 

• SignalR  

o Connection Issues for Sessions 
o General SignalR disconnections 

• StudioServer  

o Useful in most circumstances 
o Connection and General Issue Information 
o May contain user logging information 

o SignalR Disconnections per user 
• WCFService  

o Connection and General Issue Information 

o May contain user logging information 
o File Uploads, non-real-time operations 

• WebAPI  
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o Useful in most circumstances 
o Connection and General Issue Information 

o May contain user logging information 
o File uploads, non-real-time operation 

 
 

Data Transfer Test – Troubleshooting Performance Issues 
 
You can use the following test to ensure that the Studio Enterprise Server and SQL server have sufficient transfer 
speeds. Testing the transfer speeds from the Studio Enterprise Server to an end user would also be beneficial to test.   

 
• Copy a large file, like a 300+ MB file from a shared drive on the Web Server to that share mapped on the SQL 

Server. 

• Very important to note the exact start time of the transfer and the exact end times of the transfer and let me 
know exact file size transferred and the start/end times 

• Proper Steps to complete 

1. Create a file share on the target machine in which everyone can write to 
2. Map to the target share from the source 
3. Copy a large file from source to the target using the mapped drive 

4. Note the time taken 
5. Delete the mapped drive and share 

• Note: If the Server Admin is using an RDP viewer to remote into each machine, DO NOT copy a large file from 
one Sever to the other. This is not a true test because this is not Server to Server, it's over RDP. 

• Calculate data transfer rate: 

1. Example 1: (GB converted to MB/seconds) 
▪ 1.8GB file 
▪ 1.8GB = 1800MB 

▪ 1 GB = 1000 MB (in decimal). Use decimals when calculating 

▪ 1 GB = 1024 MB (in binary) 
▪ Transfer time 11 seconds 
▪ 1800/11 seconds = 163.63MB/s (Good) 

2. Example 2: (MB/seconds) 

▪ 300MB file 
▪ Transfer time 10 minutes (10 minutes * 60 seconds = 600 seconds) 
▪ 300/600 seconds = 0.5MB/s (Bad) 

3. Example 2: (MB/minutes) 

▪ 558MB file 
▪ Transfer time 1 hour 30 minutes (90 minutes) 
▪ 558/90 = 6.2MB/m (Bad) 
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Install Issues 

Install Fails as a Result of Incompatible Software 
 
Problem 
General issues with install that may be related to Software/OS Version or compatibility. 
 
Solution 

• Ensure Studio Enterprise Installation and Configuration Guide is followed during installation process. 
• For Production use, ensure SQL Express is not being used. 
• Ensure SQL server and App Server are running on separate servers. 
• Windows Server 2012 R2 is the newest Windows Server that is compatible with Studio Enterprise.  
• While SQL 2016 is currently supported, the most recent build of the installer will fail when installing to SQL 2016 

and no database is present. If installing a new database directly to SQL 2016, reference Manual Database Install 
Steps – SQL 2016. This will not be an issue when migrating databases to SQL 2016.  

• Ensure all Service Accounts are members of Local Administrators group and passwords do not expire. 
• Check Install Logs.   

o C:\Users\[account]\AppData\Local\Temp – Look for logs starting with “Bluebeam_Studio_”. 
 

Windows Authentication for SQL Connection During Installation 
 
Problem 
“Unable to validate the account [Service Account]" error during installation. 
 
Solution 
Add the Domain Account that was being used as the Service Account for the SQL connection to the Local Administrators 
Group on both the SQL & App server. 
 

Failed to Start Bluebeam Services During Installation Error 
 
Problem 
Bluebeam Services (Bluebeam Studio Job Queue and Bluebeam Studio) do not start during installation. 
 
Solution 
Try re-issuing the sites Certificate > Install it and ensure it is trusted. It must be installed in the Personal Store at the 
Local Machine level on the Studio Enterprise Server > then try re-installing Studio Enterprise. 
 

Studio Enterprise Server Migration 
 
If you are planning to move your Studio Enterprise Server, are just the IP and MAC address changing? 
If so, the good news is that the IP and MAC addressing should not impact the license since the license is registered to the 
Server computer name and not tied to any hardware addressing. 
 
If you are changing the server’s hostname, you will need ensure it is changed everywhere. This includes the machine 
name, hostname in the Studio Enterprise Administrator, Certificate, URL in IIS, etc. Before performing this migration, I 
would recommend Unregistering the Studio Enterprise server prior to the change. This can be done via the Bluebeam 
Studio Enterprise Administrator application > Tools dropdown > Unregister. After making the needed changes you can 
then re-register via the Bluebeam Studio Enterprise Administrator application to ensure the License is properly applied.  

https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
https://support.bluebeam.com/articles/sql-db-guidance-best-practices/
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Connection Issues 

General Troubleshooting for Connection Issues 
 
Note: If the below user login troubleshooting does not resolve the issue and there's a connection issue that is not obvious, 
it could be related to a Proxy, DNS routing, Firewall, or other networking issue that may require your security team to 
packet trace (Wireshark, Fiddler, or Microsoft Message Analyzer) the users connection and see what end-points the 
Studio connection is going through. 
 
Problem 
Users are unable to connect to your Studio Enterprise server with Revu or Vu. 
 
Solution 

• Start troubleshooting connection issues by taking a look at the following support site article: 
https://support.bluebeam.com/articles/troubleshooting-connectivity-issues-with-studio-enterprise/ 

• Hostname misconfiguration? 
o Compare machine name, hostname in the Studio Enterprise Administrator, Certificate, URL in IIS, and 

URL shown for endpoints in Revu logs.  

o Check for discrepancies. 
• Certificate Issue? 

o Run IE as Admin and open your Studio Enterprise portal URL. 
o Check Certificate. Is it trusted, still valid, and not expired? 
o If there is a Certificate error check the Certificate Issues section. 

• If that does not resolve issue, try the steps found in the General Error Resolution section. 

SignalR Error – Sessions Can’t Connect 
 
Problem 
Users are unable to connect to Sessions on the Studio Enterprise server. 
 
Solution 
Are there "SignalR: closed" errors in the Revu.log logs for the user or the SignalR.log on the SE server? If so, SignalR is 
the real-time component necessary for Sessions to function. SignalR protocol will need to be allowed on network 
communications for Sessions to work properly. The Bluebeam services needed for this to function may be down or need 
a restart. 
 
Open the Bluebeam Studio Administrator on the Studio Enterprise Server > Tools > Restart Server. This will restart the 
Bluebeam Services. Once the Services have been restarted, try to access one of your Sessions again. 
 

WARNING: Restarting the Bluebeam Services will cause a momentary loss of connection for active users. 
Restarting the server or any Bluebeam Services should be done in a maintenance window to avoid downtime for 
the users. Revu has an Offline mode that will allow them to continue working while the services restart, but as a 
best practice we recommend performing any disruptive changes during non-business hours. 

 
You will also need to ensure the "Bluebeam Studio Application Pool" is started in IIS (Internet Information Services) on 
the Studio Enterprise server. This is located under the Application Pool section in IIS. 
  
Reference the Can Connect to Projects but Not Sessions section if the above does not help. 
 

Unknown Error in Revu when applying permissions or attendee access settings in Revu  

https://support.bluebeam.com/articles/troubleshooting-connectivity-issues-with-studio-enterprise/
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Problem  
When attempting to modify attendee access or permissions settings for Studio Sessions or Projects in Revu, users 
receive an “Unknown Error”. Users may also receive “Unknown Error” when attempting to connect to SE server 
 
 

• This is usually related to HTTP verbs, like GET, PUT, DELETE being blocked on the Studio Server. 
• As a result of this error users may be unable to modify Session/Project permissions & uploading markups to 

Sessions may fail. 
• WebDAV can be configured to block or allow verbs.  However, WebDAV is not required for the Studio Server to 

work, so you can safely disable it. 
• The WebAPI.log Studio log file is where you would see the HTTP verbs being communicated to Studio from the 

Clients.  
 
Solution 
Disabling WebDAV  

• Disabling the feature through the Server Manager is recommended, only edit web.config if server requires 
WebDAV for another reason. 

1. Uninstall/disable WebDAV 
▪ Uninstall WebDav as a Server Role through the Server Manager 

2. Restart IIS 
3. Restart Bluebeam Services 

 
Please reference the following Support Site Article for further info: https://support.bluebeam.com/articles/unknown-
error-in-revu-when-applying-permissions-or-attendee-access-settings-in-revu/ 
 

TLS Issue – Unable to Connect Using Revu 2016 and Older 
 
Problem 
Revu 2016 and older is unable to connect to Studio Enterprise. This is due to Revu 2016 or older not supporting TLS 1.2. 
 
Solution 

• Revu 2016 and older (including Vu) does not support TLS 1.2. We recommend upgrading any users with 2016 or 
older to a newer version. 

• If it is not possible to upgrade to 2017, Ensure TLS 1.0 is enabled and ensure that Strong Ciphers are not forced. 
• I would also recommend running a .NET repair tool to see if there any issues with .NET on the Studio Enterprise 

(SE) server.  https://www.microsoft.com/en-us/download/details.aspx?id=30135 
 

Studio Server Trial Expired Error in Revu When Trying to Login 
 
Problem 
Studio Enterprise sever has been registered/working and users suddenly start receiving an error stating “The Bluebeam 
Studio Server Trial has expired” when attempting to login. 

https://support.bluebeam.com/articles/unknown-error-in-revu-when-applying-permissions-or-attendee-access-settings-in-revu/
https://support.bluebeam.com/articles/unknown-error-in-revu-when-applying-permissions-or-attendee-access-settings-in-revu/
https://www.microsoft.com/en-us/download/details.aspx?id=30135
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The JobQueue service places a token in the database every hour that is set to expire in 2 hours. If this service crashes or 
stops, the license can "expire" after 2 hours. 
 
 
Solution 

 
• If this occurs, restarting the Bluebeam Services from the Studio Enterprise Administrator (Tools > Restart Server) 

should restart the service and re-engage the license. You may need to click Restart Server a second time if it 
doesn't take the first. 

o WARNING: Restarting the Bluebeam Services will cause a momentary loss of connection for active 
users. Restarting the server or any Bluebeam Services should be done in a maintenance window to avoid 
downtime for the users. Revu has an Offline mode that will allow them to continue working while the 
services restart, but as a best practice we recommend performing any disruptive changes during non-
business hours. 

• You may need to re-enter their Serial Number and Product key to fix this issue. 
• Set services to automatically recover. If you open services.msc (on the server where Studio Enterprise is 

installed), right-click on the 2 Bluebeam Services and go to Properties. Select the Recovery Tab and configure 
the failures to Restart the Service. This should automatically restart them in the event of a failure. See the 
below screen shots. 

 
• More information on this issue can be found in the following support article: 

https://support.bluebeam.com/articles/users-receiving-a-studio-server-trial-has-expired-error-when-trying-
to-login-through-revu/ 

https://support.bluebeam.com/articles/users-receiving-a-studio-server-trial-has-expired-error-when-trying-to-login-through-revu/
https://support.bluebeam.com/articles/users-receiving-a-studio-server-trial-has-expired-error-when-trying-to-login-through-revu/
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Can Connect to Projects but Not Sessions 
 
Problem 
Users unable to connect to Sessions but are able to connect to Projects. 
 
Solution 

• Verify Revu version. Ensure users are running Revu 2015 – Revu 20. 
• Ensure the BluebeamCache Database exist on the SQL server.  
• Check Studio Enterprise Administrator > Status > Is there an IP address in the Hostname field? If so, change to 

the Servers FQDN. You will need to restart the server for change to take effect.  
• Reference the SignalR section if the above does not help. 

 

Internal Users Can Connect but External Users Cannot 
 

Problem  
Users on the internal network are able to connect but users on an external network are unable to. 
 
Solution 

• Is a proxy present?  
o If so, ensure URLs are being properly routed. 
o Ensure Proxy Re-authentication is disabled for server URL. 

• Ensure Firewalls are configured correctly and allow external traffic. 
• Ensure a public IP is being used. 
• Is the external user using a VPN? If so, ensure it is setup to allow connection to the SE server. 
• May be related to network issues. 

o Ensure the SE server is whitelisted. 
o Test another network to see if it is network specific. 

• Check Active Directory configuration. Are the external users’ members of the domain?  
o If not, ensure Mixed Mode Authentication is used so outside users can create accounts. 

• Certificate Issue 
o Is the certificate self-signed? If so, the end user will need to import certificate into Trusted Root 

Authority. 
o Reference Self Signed Certificates section for information on this. 

• Check Revu Client and Server logs to look for errors. 
 

Users Can Connect but Are Disconnected After Some Time - Proxy Re-Authentication Not 
Supported 
 
Problem 
Users are able to connect to the SE server in Revu fine, but they are disconnected after a period of time.  
 
Solution 
Disable Proxy Re-authentication 

o You will need to ensure any present proxy does not require re-authentication with the Revu client. Revu will 
not resend credentials re-authentication tokens.  

o Revu is Proxy Aware if the proxy configuration is recognized as valid, but only on initial login to Studio. It uses 
whatever Proxy is setup in the IE browser and will send those credentials, but it will only send the credentials 
that one time. It will only send the credentials on the initial connection attempt or when a user reconnects 
manually. 
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Active Directory (AD) Integration Issues 

LDAP Configuration Guidelines 
 
Problem 
Unable to successfully configure LDAP and AD Integration configuration in the web portal. 
 
Solution 

• Reference the AD Integration portions of the Studio Enterprise Installation and Configuration Guide for 
guidelines on AD Integration. 

• Verify LDAP String is correct. 
o Try top-level domain before OU's or CN’s to simplify the string.  It’s best to let LDAP point to the top-

level domain (root domain) 
o Here are some example Strings 

▪ LDAP://OU=users,DC=company,DC=local 
▪ LDAP://dc.company.local/ 
▪ LDAP://domain-controller/dc=company,dc=local 

o The OU which contains the AD Users and SPN account should be children of the LDAP string location. 
▪ The LDAP string should include the OU where all the users who will be logging into Revu are 

located as a child.  
o Do not include AD Groups in the LDAP string 
o Verify users have not moved to a different OC or CN. 
o Verify if you are using the Domain name or the name of the Domain Controller. 

▪ You can use the domain's name in the connection string as opposed to the name of a domain 
controller. The difference is that the domain's name will resolve to the IP address of any 
domain controller in the domain. That can be both good and bad.  

▪ If using the name of the Domain, you are not reliant on any single domain controller to be up 
and running for the membership provider to work. But if the name happens to resolve to, say, 
a DC in a remote location with spotty network connectivity then you may have problems with 
the membership provider working. 

▪ On the other hand, if you use the name of Domain Controller and that DC goes down, no one 
will be able to connect. 

▪ When configuring the LDAP, you are only able to enter one DC (domain controller).   
o You can find more guidance on LDAP Strings from Microsoft. Here is an article that further details LDAP 

Strings. https://docs.microsoft.com/en-us/windows/win32/adsi/ldap-adspath 
• Verify SPN is configured correctly, credentials are valid, and account can query all necessary fields. 

o It’s best to ensure Service Accounts passwords are set to never expire. 
o Ensure Security Principle is a member of the Local Administrators Group on the SE Server. 
o Security Principal needs "Read" permission in Active Directory. 
o More information on setting up and troubleshooting the SPN can be found below. 

• Domain Users must have an email address configured to be mapped properly. Check the Mapping Issues section 
for more info. 

• Use the Active Directory Diagnostic Scripts to troubleshoot issues. 
o Download Link: https://studio.bluebeam.com/share/drbgr2 
o Password: SEsupport123 
o The “domainconfigdiag” script will help validate your LDAP connection string, Security Principal 

Credentials, and that Studio can query all of the required fields in order for AD integration to work. 
o Instructions included in download. 

 
 

https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
https://docs.microsoft.com/en-us/windows/win32/adsi/ldap-adspath


18 

 

SPN - Security Principle Name Configuration Guidelines 
 
Problem 

• Unable to configure AD Integration 
• Users are not being mapped from AD 
• AD users are unable to login 
• Security Support Provider Interface (SSPI) authentication failed. 
• There is no SPN set to authenticate users when using AD and Windows Authentication 

 
Solution 
For the Service Account to authenticate users seamlessly when Windows authentication is used, it must be registered to 
the following Service Principal Name: BLUEBEAM/studio 
 
Reference the SQL Authentication vs. Windows Authentication section of the Studio Enterprise Installation and 
Configuration Guide for information setting up a Service Principal Name (SPN). 
 

• Test if account is already setup in Active Directory using Power Shell  
o Run following command in PowerShell: “setspn -q BLUEBEAM/studio -F” 

▪ Found: Should return Existing SPN Found and the name of the SPN 
▪ Not Found: Should return Not Found 

o Ensure the Service Account used for SPN is a member of the Local Administrators Group on the SE 
server. 

o The SPN account should have a password that does not expire. 
• Set SPN in Active Directory 

o Ensure the account you are running PowerShell as, is a member of Domain Admins. 
o Run following command in PowerShell, adjusting command to with domain and service account. 
o “setspn -S BLUEBEAM/studio DOMAIN\SERVICEACCOUNT” 

• The SPN account may no longer exist or the password may have expired. 
• You can check which account is used as the SPN by logging into the Studio Enterprise Portal in a web browser 

and looking under the AD Integration page. You may need to reset the Security Principal password. 
• Check for duplicate SPNs: 

o Run following command in PowerShell: “setspn -x” 
• Unregister SPN 

o Run following command in PowerShell: “setspn -D BLUEBEAM/studio DOMAIN\SERVICEACCOUNT” 
 

AD Group Requirements 
 
Problem 
AD Groups are configured in AD Integration page of the SE web portal, using the Use AD Group option. If you chose to 
restrict Studio Enterprise Accounts by AD group, reference the below Solution section to troubleshoot issues. 
 
Note: Using Groups can be inefficient when there a large number of AD objects.  If you experience any AD query timeout 
issues, it's best not to use Groups. 
 
Solution 

• AD Group Properties 
o Security Group (Supported) 
o Distribution Groups (NOT Supported) 
o Scope must be set to "Global" in AD 

• Users must be direct members of a "Security" group. 

https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
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• SPN must be a direct member of the "Security" Group in order to authenticate Group members. 
• Cannot use default AD groups like "Domain Users". 
• Users MUST have an email address configured. 
• Not following these requirements may result in the following: 

o Users show up under AD Manage Users > All Users but cannot login  
o Existing studio users don't auto-map.  
o Users can't login with Windows Authentication/AD Credentials 

• When making group member changes, you should not have to restart to see the changes or additions; it should 
be automatic. Ensure that these users are direct members of the AD group itself. If a user is in a subgroup of the 
group, they will not show up in the AD Manage Users Query and may not be able to login. 

• Ensure the user has a login name under both “User Logon Name” and “User Logon Name (pre-Windows 2000)” 
in AD.  

 

Mapping Issues 
 
Problem 
Users are unable to login to the Studio Enterprise server from the Revu Client. Certain AD users are not being mapped 
successfully. The AD user is not found on the AD Manage User page in the Studio Portal. 
 
Solution 

• Verify that all the required fields in AD contain data and can be queried. All these values are mandatory. 

 
• Are you using AD Groups in the AD Integration options (This can be found in the SE web portal)? 

o Login can be slow with lots of groups and potentially timeout. 
o Simplify this configuration if this is the case. 
o If using AD Groups, ensure users are members. 

• Ensure the AD Users are included as a child of the LDAP string 
o Try updating the LDAP string to point at the top-level domain (root) 
o  Try a few different tests, moving users to a different OU, creating new users, etc. to see if anything 
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helps 
• Ensure user is a member of Domain Users. 
• If you have Windows Authentication enabled for the Service Account and can manually enter AD credentials but 

can’t login with check box. The SPN may need to be investigated.  
o Check the SPN section to troubleshoot the SPN configuration. 

• Ensure the server you are connecting to is not one of our cloud servers (studio.bluebeam.com or 
bluebeamstudio.co.uk). 

• After verifying all the above, you can then select Auto-Map Users in the AD Integration tab of the portal to try 
and map users.  

 

Can No Longer Login with AD Credentials 
 

Problem 
Users who were previously able to login with AD credentials are no longer able to. 
 
Solution 

• If using Mixed Mode Credentials, do regular Studio (non-AD) accounts work? 
• Is the account password valid?  

o Check with a Network Administrator to ensure your Active Directory account is active and the password 
is correct. 

o If unsure, reference the Reset Studio Account Password section. 
• Has the SPN password changed? 

o Check the above SPN section to troubleshoot the SPN configuration. 
• Check logs from Revu Client & Server. 
• Verify LDAP String. Check LDAP Configuration Guidelines for details on this. 

 

Active Directory Error Messages in Logs 
 
Problem 
The main cause of the error seen below is due to the limitations of directory searches done on the Manage AD Users 
page within the Studio portal. 

ERROR - Bluebeam.Studio.AdminPortal.Core.DomainAccountRepository - 
System.Runtime.InteropServices.COMException (0x8007202C): The server does not support the requested critical 
extension. 

 
Information on Issue 
To clarify, the issue itself is caused by the Directory Searcher components within Microsoft's libraries that we are 
leveraging to search for Users that exist under the configured LDAP path. The issue occurs when there are more than 
2000 users under the configured path, which is near default cutoff for the maximum number of results that AD will 
return for any query. As this is a Microsoft limitation we are unable to provide specific remediation steps, but this article 
details possible solutions. 
 
WARNING: We do not recommend increasing the search buffer size as it could cause unforeseen performance issues for 
the AD infrastructure. 
 
Problem 
The Security Principal is no longer valid. The below error is given. 

ERROR - Bluebeam.Studio.AdminPortal.Core.DomainAccountRepository - Please check that the configured Studio 
security principal is still valid. The principal may no longer exist, or the password may have expired. 

https://www.itprotoday.com/active-directory/conquer-active-directory-s-built-limits
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Solution 
In some cases, this error does not affect functionality and is triggered by the “DomainAccountRepository” error above. If 
this is not related to the above issue “DomainAccountRepository” error and users are unable to connect with AD 
accounts, the SPN may be misconfigured. In this case check the above SPN section to troubleshoot the SPN 
configuration. 
 

AD User is Not Found on The AD Manage User Page in Studio Portal 
 
Problem 
Certain AD users are not being mapped successfully. The AD user is not found on the AD Manage User page in the Studio 
Portal. 
 
Solution 

• Ensure the AD Users are included as a child of the LDAP string. 

• Ensure the user has an email address in their AD User Object.  

• Try updating the LDAP string to point at the top-level domain (root) 

• Check Mapping Issues section for more details. 
 

AD User Left the Company and was Rehired 
 
Problem 
If a user was deleted from AD, Studio Enterprise does not know about it. The user account will still live on in the SE 
environment. If a user has been rehired and they need an account, they will need to remap it. 
 
Solution  

1. Login to the Studio Enterprise Web Portal with an Administrator account.  
2. Open the AD Manage Users window.  
3. Find the user in question and select Unmap User. 
4. The user should then attempt logging into Studio Enterprise again. 

 
Note: If the user account in "AD Manage Users" does not have an email listed and the "unmap user" option is not 
available, go into the Studio Portal, locate the user account and click on "Update Profile".  This may be required to 
refresh the user account and get it mapped where we can finally "unmap user" and have the user log back into 
Studio via the Revu client and their account will get re-mapped properly. 

 
If the above steps do not resolve the issue, you can delete the user from the database directly: 

▪ Execute SQL query " delete from T_ActiveDirectoryUser where DomainEmail = 'user@company.com' " 
▪ Refresh the web portal and try to remap the user.  
▪ Last resort - If that fails, we'll need to try and delete the user from T_User table.  When doing this, you will get 

errors where there are DB constraints against the user, from other tables.  You will need to go through and 
delete the user from every table that shows a constraint, before you can finally delete the user from T_User 
table. 
 
WARNING:  The above SQL changes have the possibility of causing data loss or DB corruption.  An experienced 
DBA should be involved for any of these changes. Backups should be made of the DB, prior to any changes. 

 
 
 



22 

 

Reset Studio Enterprise to Studio Credentials Only 
 
Problem 
If Studio Enterprise ever gets stuck in an AD Configuration that is corrupted or no longer working, you may need to force 
the configuration back to its default. To do this, SQL scripts will need to be ran to change back to Studio Credentials 
Only.  
 
This solution may also be useful for customers that can no longer login to the Portal because their LDAP settings are 
misconfigured, or they don’t know the password for the Admin account.  
 
Solution 
A SQL script will need to be ran in this circumstance. This will delete all AD configurations, meaning that it will unmap all 
users, configuration settings, and reset it to studio credentials.  This should be used as a last resort. As long as the users 
email addresses have not changed, their Sessions will still be associated. Sessions are correlated by email address. After 
AD is re-integrated, users will get remapped as soon as they log in. 
 
Reference the Reset Studio Credentials Script section for the script in question.  
 

Unable to Login With AD  
 
Problem 
Unable to login with Active Directory. Log shows Object Reference error when logging into Studio. 
‘System.ServiceModel.Diagnostics.TraceUtility’ - ‘AccountCreateResponseDto’ Errors. 
 
Receiving ‘System.ServiceModel.Diagnostics.TraceUtility’  errors. Finding errors in logs and event viewer related to .NET. 
Exception similar to the following: 

System.TypeInitializationException: The type initializer for ‘System.ServiceModel.Diagnostics.TraceUtility’ threw an exception. -→ 

System.Configuration.ConfigurationErrorsException: Configuration system failed to initialize -→ System.Configuration.ConfigurationErrorsException: The ‘configuration’ start tag on 

line 12 position 2 does not match the end tag of ‘system.data’. Line 172, position 7. (C:\Windows\Microsoft.NET\Framework64\v4.0.30319\Config\machine.config line 172) -→ 

System.Xml.XmlException: The ‘configuration’ start tag on line 12 position 2 does not match the end tag of ‘system.data’. Line 172, position 7. 

 

You may also receive the following error when trying to create a New Studio Account. 

 
 

Solution 
These issues are related to an unhealthy .NET state on the SE server. 

• First, I would recommend running a .NET repair tool to see if there any issues with .NET on the Studio 
Enterprise (SE) server that can be repaired.  https://www.microsoft.com/en-
us/download/details.aspx?id=30135 

• If repairs do not help .NET may need to be reinstalled.  
a. Uninstall Studio Enterprise 
b. Server Manager 

i. Remove Roles and Features on the web server - Select .NET 4.5 & .NET 3.5 to uninstall 

https://www.microsoft.com/en-us/download/details.aspx?id=30135
https://www.microsoft.com/en-us/download/details.aspx?id=30135
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ii. Restart the server 
iii. WARNING: This leaves the Server core installed without a GUI. Only the Admin CMD Prompt is 

available 
c. Command Prompt 

i. Reinstall the GUI through PowerShell - https://www.linkedin.com/pulse/20140618170857-
12975178-procedure-to-recover-gui-in-windows-2012-and-2012r2-net-framework-feature-
dependency-in-windows-2012-2012-r2/ 

d. Server Manager 
i. Add Roles and Features - Select .NET 4.5 / 3.5 to install 

ii. Restart the server 
e. Re-install SE 

 

“Please map at least one studio admin account to a domain user that exists…” Error 
 
Problem 
Receiving the “Please map at least one studio admin account to a domain user that exists under [LDAP String] to avoid a 
system logout” error when setting up Active Directory Integration. 
 
Solution 
This is related to setting up with Active Directory Credentials Only. I would recommend setting up this configuration 
with Mixed Mode Credentials initially. That way you can then test the AD integration after setting it up and verify 
everything works as desired. If AD Integration is set to AD Credentials Only to start off, there is a risk that you cannot 
access the portal with your current non-AD Studio Administrator Account.  
 
Integration should be setup with Mixed Mode Credentials and when it is setup, you will then need to set some of the 
users that are mapped from AD, to be Administrators in the portal. The error you are seeing is a result of attempting to 
switch to AD only, but no accounts have Admin access. When Mixed Mode is on, you will then go to the Users panel > 
select an AD user that you wish to make a Portal Administrator > and then select the Administrator role and press 
Update Profile. We also recommend setting a few accounts to have the Administrator value to ensure there is a backup 
if you lose credentials for the main admin account. 
 
Here is an example of the Administrator role change and sample values that you can use as reference when you build 
the connection. 
 

 

https://www.linkedin.com/pulse/20140618170857-12975178-procedure-to-recover-gui-in-windows-2012-and-2012r2-net-framework-feature-dependency-in-windows-2012-2012-r2/
https://www.linkedin.com/pulse/20140618170857-12975178-procedure-to-recover-gui-in-windows-2012-and-2012r2-net-framework-feature-dependency-in-windows-2012-2012-r2/
https://www.linkedin.com/pulse/20140618170857-12975178-procedure-to-recover-gui-in-windows-2012-and-2012r2-net-framework-feature-dependency-in-windows-2012-2012-r2/
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Certificate Issues 
 

Certificate Change  
 
Information on Certificates can be found in the Studio Enterprise Installation and Configuration Guide. When you obtain 
the replacement certificate, it must be installed in the Personal Store at the Local Machine level on the Studio 
Enterprise Server. 
 
Once the certificate has been installed in the Personal Store you will then be able to change the certificate.  

1. Open the Bluebeam Studio Enterprise Administrator on the Studio Enterprise Server. 
2. On the Status tab, ensure the Hostname matches name on the Certificate. 
3. Select the Certificate Configuration tab on the left. 
4. Press Change Certificate and select the new Certificate. Press OK. 
5. Press Apply. You will receive an alert about restarting services. Press Yes to restart Studio Enterprise Services 

and apply certificate changes. 
6. In most cases you will also need to change the certificate in IIS (Internet Information Services) to ensure you can 

connect to the web portal. Open IIS on the Studio Enterprise server. 
7. Find the Bluebeam Studio Server Site. Right-click and select Edit Bindings....  
8. Select the https binding and select Edit... 
9. Change the SSL Certificate to the new certificate being used by the Studio Enterprise server. Press OK. 

o Note: If you are unable to connect to the web portal after the SSL change, you may need to ensure that 
the IP Addressed is assigned in the https bindings. 

10. Press OK.  Restart IIS on the Application Server (via command line as an admin by entering the following: iisreset 
/restart). 

11. Test connectivity to Studio Enterprise server via both Revu and web browser. 
 

WARNING: Performing these actions will result in the loss of connectivity for active users. If this is a concern, schedule 
downtime to perform the certificate change. 
 

Can't login, Can't Access portal, https://localhost fails to load anything 
 
Problem 
Unable to access SE server from Revu Client. Cannot access SE Portal from a web browser. https://localhost fails to load 
on the SE server. 
 
Solution 

1. Check Certificate Bindings in IIS 
1. Open IIS (Internet Information Services) 
2. Select Bluebeam Studio Server  
3. Select Bindings…  
4. Edit Site Binding for port 443  
5. Ensure IP Address is assigned  
6. Ensure SSL certificate matches the certificate used in Bluebeam Studio Administrator 
7. Restart IIS on the Application Server (via command line as an admin by entering the following: iisreset 

/restart) 
 

2. The Certificate may need to be changed if it is invalid. If the Certificate needs to be changed check the 
Certificate Change section above. 

 

https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
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3. IIS may be corrupt. If the above steps do not help, try the following.  
1. Uninstall Studio Enterprise  
2. Uninstall IIS components from Server Manager  
3. Reboot Server  
4. Re-install (reselect) IIS components from Server Manager (DO NOT select WebDAV)  
5. Re-install Studio Enterprise 

 

Certificate Could Not Establish a Trust Relationship  
 
Problem 
When connecting the Studio from the Revu Client and you get the below error, the certificate was misconfigured when 
created. “The underlying connection was closed: Could not establish trust relationship for the SSL/TLS secure channel.” 
Error. These errors are commonly related to a self-signed certificate. 
 

 
 
Solution 
If the Studio Server is not on a Domain, but the Certificate was issued by a Domain address, remove the Domain and 
recreate the Certificate.  
 
Note: The Certificate name must match the Server Hostname. If the Machine name has .com in it, but this Server is not 
on a domain then remove the .com from this field name and create a new Certificate. 
 

Self-Signed Certificate  
 
Problem 
Users are unable to connect to SE. A certificate error is given, or the certificate shown when the portal is used is invalid. 
If there is an issue with the certificate the Revu Client log would show an error like this: 
 

 The underlying connection was closed: Could not establish trust relationship for the SSL/TLS secure channel. 
System.Net.WebException: The underlying connection was closed: Could not establish trust relationship for the 
SSL/TLS secure channel. ---> System.Security.Authentication.AuthenticationException: The remote certificate is 
invalid according to the validation procedure. 

 
 
Solution 
The problem is most likely that the self-signed certificate Studio Enterprise is using, is not installed on the end user’s PC. 
As a result, Revu will fail to connect due to security errors, likely shown in the Revu logs. 
 
The first thing to check is that when entering the server name into Revu that you are not entering https:\\ as this can 
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cause an issue. 
 
Next, open Internet Explorer > Visit the Studio webpage (https:\\servername)   > You'll see a certificate error > Choose 
to View the error > Install > Make sure that "Show physical stores" is checked > Place in local computer under Trusted 
Root. This will ensure that the certificate is trusted for all users on the computer. 

 
 
An SSL belonging to a Trusted Root CA, would automatically authenticate a user when the Revu client connects to the 
server, so it sounds you may be using a self-signed certificate since it needs to be installed. Check to see if the name on 
the certificate matches the machine name, which should match the host name in the Studio Administrator. This is what 
you'd need to use as the URL in Revu if there is a discrepancy anywhere Revu would fail to connect with security errors. 
Some more details on Certificate naming can be found below. 
 
Certificate naming: 
The Self-Signed certificate name should match the Host name of the Studio Server. 
In the Studio Administrator, click on “Status” and look at the Hostname.  The Certificate name needs to match this. 
 
If the Studio Server is not on a Domain, but the Certificate was issued by a Domain address, remove the Domain and 
recreate the Certificate.  Note: The Certificate name must match the Server Hostname: 

 
 
If the Machine name has .com in it, but this Server is not on a domain then remove the .com from this field name and 
create a new Certificate. 
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                                                                             Studio Administrator  
Hostname: EXAMPLE.DOMAIN.LOCAL                                               Certificate viewed from Certificate Configuration page 
 

 
 

iPad Users Can’t Connect 
 
Problem 
Revu for iPad users are unable to connect to the Studio Enterprise server, but Revu for Windows machines are able to. 
 
Solution 
In most cases, this is a result of using a self-signed certificate for the SE environment. Revu for iPad requires a valid SSL 
Certificate in order to connect. As a result, we usually recommend a valid 3rd Party Certificates or any certificate that 
belongs to a Trusted Root CA. If iPads need to connect, the self-signed certificate would need to be installed on the iPad. 
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Studio Portal Issues 
 

Change Password Tab Missing from Studio Portal for Some Users 
 

Problem  
The Change Password tab is missing from Studio Portal for some users. 
 
Solution 
We hide the Change Password tab for users that are created via AD. That is, if a user logs in via Revu for the first time 
using their Active Directory credentials, then a Studio user with no password is created and hence cannot be 
changed.  We also do the same thing for Studio users that are mapped to AD accounts.  AD users must change their 
password via AD. 
 

"Enter a valid host name." Error When Attempting to Open SE Portal in Web Browser 
 
Problem 
A “enter a valid host name." error is received when attempting to open SE Portal in a web browser. 
 
Solution 
This is a result of using a "_" character in the server host name while configuring the server. To resolve the issue all the 
server host name and all references should be changed to not include the “_” character. Compare machine name, 
hostname in the Studio Enterprise Administrator, Certificate, & URL in IIS. 
 

Establishing a New Studio Administrator if the Original Administrators Password is Lost 
 
Problem 
Unable to login to Studio Enterprise portal as an Administrator. This could be a result of the original Admin leaving the 
company with no backup admins. 
 
Solution 
If you have a user with Administrator access you can set another user to have the Administrator role by referencing the 
User Administration and Reporting section of this document. If the Administrator has lost their password, the password 
can be reset by following the Reset Password section of this document. 
 
If using AD Credentials Only, you may need to reset the credential type to Studio Accounts to allow you access. Please 
reference the Reset Studio Enterprise to Studio Credentials Only section for further details.  In most circumstances, I 
would instead recommend working with IT to gain access to the AD account that previously had SE Portal Administrator 
permissions and logging in with those credentials. 
 
If there are no users who have Administrator permissions to the Studio Portal, you'll need to edit a user directly in the 
Database and grant them access. 
 

1. Use a present non-AD Studio Account or create a new Studio Account that is not mapped to AD. This account 
will be granted Administrator rights. Use the Revu’s login dialog, reference Creating User Accounts section for 
steps on creating an account.   

2. You can then try to log into the Portal with that user’s Studio Account. 
3. With the help of a Database Administrator the following command can be ran on the BluebeamStudio database: 
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--Script to set user account as admin. Replace email address on line 5 with desired email address. 
USE BluebeamStudio 
GO 
 
DECLARE @myEmail nvarchar(max) = 'sample@email.com'; --Enter email address here. Replace 
"sample@email.com" 
 
DECLARE @myUserID INT 
SELECT @myUserID =  [UserID] FROM T_User WHERE Email = @myEmail 
 
PRINT CONCAT('Email: ',@myEmail) 
PRINT CONCAT('UserID: ',@myUserID) 
 
UPDATE T_User 
SET UserStatus=0, ServerAccess='True' 
WHERE Email=@myEmail 
 
if exists(SELECT * from T_UserRole where UserID=@myUserID)             
BEGIN             
 update T_UserRole set RoleID=1 where UserID=@myUserID   
End                     
else             
begin   
insert into T_UserRole values(1,@myUserID)   
end 

 
4. The customer will need to update the email address on line 5 with the email address for the account they wish 

to make an Admin.  
5. After running the script, log into the portal once more to verify admin access has been granted. 

 

Studio Sessions Markups are Not Updating in Real Time 
 
Problem 
Multiple users are connected to a Studio Session. Each user can only see updates to markups they place but not of other 
users.   
 
A previous workaround was that the users could leave the Studio Session and then reconnect. Upon reconnecting, the 
markups would update; however, the issue would persist once any other users applied new markups.  
 
Error Sample (multiple instances of the same error - found in StudioServer.log located in: 
C:\Users\WindowsUserAccount\AppData\Local\Temp\Bluebeam Software):  

2019-02-16 13:43:10,670 [5] INFO Bluebeam.Studio.Service - Bluebeam Studio service started 

2019-02-16 13:43:10,749 [Server Thread] ERROR Bluebeam.Studio.Service - Failed to start server thread 

System.Exception: Certificate Error. Could not find the certificate with the hash string: 7E2AF6DD5DADF017DC2A58F2C6DAC4B5929AE4E2 

at Bluebeam.Studio.Service.?(Object ) 

2019-02-16 13:43:11,092 [Server Thread] INFO Bluebeam.Studio.Service - Bluebeam Studio service stopping 

2019-02-16 13:43:14,096 [Server Thread] INFO Bluebeam.Studio.Service - Bluebeam Studio service stopped 

 

Solution 
1. Launch the Studio Enterprise Administrator (on the App Server).  
2. Go to Certificate Configuration 
3. Click View Certificate (in some instances it will not indicate there's a problem with the certificate, yet the issue is 

present. In other instances, a pop-up will indicate "Certificate Not Found") 



30 

 

 
4. Click the Change Certificate button 
5. There may be more than one. Verify the correct one (should be the one with the latest dates, etc.). The issue 

we've found is that even though they created the Cert in the Administrator, the check box is not checked as 
shown below. Therefore, they need to check the box and click OK.  

 
6. This will require a restart of the Studio Enterprise instance (Administrator > Tools > Restart Server) 
7. In most cases, this will also require a reboot of the Web server.  

a. Via command line as an admin by entering the following: iisreset /restart Advise the customer this 
should be performed as a Maintenance Window (with no users connected to Studio).  

8. Once services are back online, we advise you to perform tests to see if issues are no longer present. 
 

Studio Web Portal Prompts Users to select a Client Certificate 
 
Problem 
Studio Web Portal prompts users to select a Client Certificate. 
 
Solution 
This is an issue with the IIS configuration. To prevent this prompt, open IIS on the Studio Enterprise server, select the 
Bluebeam Studio site and double-click SSL Settings. Un-check Require > Set Client Certificates to Ignore > apply the 
settings. Perform an IISRESET after this change. 
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Profile Information is Blank in Studio Portal  
 
Problem  
Users profile information is blank in Studio web portal. This is likely related to an issue with their email address. 
 
Solution 
If a Studio Account was created with an email address containing an apostrophe or another invalid character, their user 
profile may show up blank in the web portal.  
 
To resolve this, change the users email value in the T_User table of the database to not include the apostrophe. You 
should then be able to change the users email in the Studio Enterprise web portal to the correct email address. When it 
is changed in the portal you can then change the database value back. 
 

User is Connected to the Wrong Session/Project 
 
Problem 
User logs into Studio and clicks on a Session or Project ID in the Revu Studio panel, but the user is then connected to the 
wrong/different Session or Project ID. 
 
Solution 
As a Studio Administrator, log into the Studio Portal and find the users profile.  Make any change to their profile, like 
change their User Role and hit Update Profile.  Revert the change and click Update Profile again.  Have the user try 
connecting to their Session or Project and verify they are connected to the proper Session/Project ID.   Making a profile 
change causes the Studio database to rebuild the users Profile and usually fixes the above issue. 
 
If this does not resolve the issue, it may be related to the Technician Role being selected in the user’s profile. In this case 
deselect the Technician Role for the user and click Update Profile. 
 

Session Status and Properties Panel - Portal 
 
If your user account has the Administrator role, it will have access to Administer the server via the web portal.  
Once you login to the web portal for the Studio Enterprise server with an Admin account you will be able to find 
Sessions by selecting Sessions on the left-hand side of the window.  
 

 
 
You will be able to search through the Sessions to find any Sessions that meet your criteria or sort by a specific column. 
In the above image you can see the Sessions are being sorted by Status. 
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If you select a Session, there are several different tabs with potentially useful information. If you wish to change the 
Status of a Session you can do so by selecting the new Status in the Profile tab and selecting “Update data”. I would 
recommend that you download any documents from a Session if you need them, prior to changing the State to anything 
other than Active. 

 
 
You can also query the Session status directly from the Studio Enterprise server’s database. Use the Return Session 
Status Script to do so. 
 

User Administration and Reporting 
 
If a user account is set to Suspended in the Studio Portal, that user can no longer access Studio.  This is a useful setting 
for any users that are no longer employed or project partners that do not require access any more. To find if a user is 
suspended, you can log into the Studio Enterprise Portal via a web browser > Log in with an admin account > Select 
Users on the left. You can see if the user is Suspended by looking at the User Status column. 
 

 
 
To change the Suspended Status, select or search for the user > under the Users Profile you can see if the account is 
Suspended by checking Server Access. If it is Allowed, they are NOT Suspended, if it is Restricted, they ARE Suspended. 
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Users with the Administrator role will have access to Administer the server via the web portal. The Studio Enterprise 
Install and Config Guide details the different roles behavior. Only Administrators will have access to all the control 
options in the portal. All other users will only have access to the My Sessions and My Profile Tabs. 
 
 
There is no reporting feature for the user list, though you can select them all and copy them into an excel sheet. This will 
just take some formatting. 
 
You can also use the SQL database to collect this information.  Please reference the Return User Role Information Script 
section for more information on this.  
 
Further information on User Roles: https://support.bluebeam.com/articles/what-are-the-roles-for-user-accounts-in-the-
studio-portal-used-for/ 

Suspended Account – Reference if you wish to Delete or Remove a User 
There is no official/supported/recommended way to delete a user from Studio Enterprise. If a user needs to be 
removed, instead set Server Access to Restricted as detailed above. More information on this process can be found on 
our support site article How to revoke user access for Studio Enterprise. 
 

User Automatically Switching Between Sessions on SE Server Issue  
If a user experiences an issue where their account switches between Sessions without their interaction, it is related to 
the Technician Role being selected. In this case deselect the Technician Role for the user. 
 

Reactivate Project 
 
This can be done by logging into the Studio portal by entering your company's Studio Enterprise server into a browser:  
Example: https://bluebeam.[company].com 
 
Sign in with a Studio account with Administrator permissions. Once they are logged in, they can undelete a Project or 
Project item by selecting the Project Undelete option on the left-hand side. 
 
More information on this process can be found on the Project Undelete Page section of the Install and Config Guide. 
 

Restricting Domains / Restricting User Permissions 
 
You can restrict access to your Studio Enterprise (SE) server via the Server Permissions page in the SE Portal. These 
configurations details can be found in the Studio Enterprise Installation and Configuration Guide. 
 
This method will only let you deny specific domains, but it will not allow you to blanketly deny all domains other than 
the ones you allow. For example, if you specify both @domain1.com and @domain2.com as allowed domains, all other 
domains would still be accessible. There is no way to use a wildcard to deny all possible domains, instead any domain 
you want to deny will be allowed until it is entered here.  
 
Furthermore, if you set the Studio Users Default to Deny, but have a Domain set to Allow, that domain will still have new 
accounts created with Deny permissions, as it will take the most restrictive permissions. Here is an image depicting this 
setting. 

https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
https://support.bluebeam.com/articles/what-are-the-roles-for-user-accounts-in-the-studio-portal-used-for/
https://support.bluebeam.com/articles/what-are-the-roles-for-user-accounts-in-the-studio-portal-used-for/
https://support.bluebeam.com/articles/how-can-i-prevent-an-existing-user-from-accessing-the-server-anymore/
https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
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If 'Studio Users Default' is set to Deny, anyone who creates a new account will have their values set to Deny. If you do 
not have many new users, this may be a path forward, you could restrict the whole server and then you will need to 
manually approve new users’ access. If you had this configuration you would then go to the Users panel and change 
their access from Restricted to Allowed.   
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Miscellaneous 
 

SMTP Email Server Issues 
 
Problem 
Studio Emails are not being successfully sent to users outside of their network. 
 
Solution  

• Log into the Studio Portal with an Administrator Account and check the E-mails tab. 
o When Studio emails are successfully sent form the server, in the Studio Web Portal, the status code for 

that e-mail reads "200". 
o When the status code for an e-mail reads "999" that means that the e-mail wasn't successfully sent. 

• If a “999” error occurs and the Studio Enterprise Admin has set up their email client with Microsoft Exchange, 
try to check the "Externally Secured (for example, with IPsec)" option in the Exchange Management Console 

 
• Other Issues  

o Reference SMTP sections in the Studio Enterprise Installation & Configuration Guide. 
o Ensure all settings in the E-Mailer Service panel of the Bluebeam Studio Enterprise Administrator are 

valid. 
▪ Verify SMTP FQDN is valid and can be connected to. 
▪ Ensure the port is valid and open. 
▪ Ensure Service Account Username is valid. 
▪ Ensure the associated password is correct and not expired. 
▪ Ensure E-Mail and Reply To-Emails are valid.  
▪ Test with and without Enable SSL checked. 

o Send Test E-Mail in E-Mailer Service panel. 
o Ensure Enable E-mail Notifications is selected in E-Mailer Service panel. 
o If you search the internet you can find web-based SMTP test tools. You can use one of these tools from 

the SE server to test the connection and troubleshoot. 
• E-Mail Statuses 

o 0 = Pending 
o 100 = Sending 

https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
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o 200 = Sent 
o 999 = Error 

• Example of settings: 

 
 
 

Maximum File Upload Size 
 
By default, the maximum upload size of a document is 1GB. It is possible to increase this value from 1GB to the 
Maximum possible upload size of 1.99GB. As a result, large files are unable to upload while smaller files upload 
successfully. 
 
The current limitation is due to the following reasons: 

1. In Revu, the HTTP client used to send requests to the server has a default limit of 2 GB within the code 
(Microsoft side) that limits file sizes that are read into memory before being sent. 

2. The current SE file upload implementation attempts to load the entire file into memory before saving it to the 
Studio Database. 

3. Due to the IIS request size implementation, the content of each web request can only be a maximum of 1.99 
GB.  This impacts all files uploaded. 
 

What are the steps to increase the limit on my installation of Studio Enterprise 3.1? 
In order to increase the upload file size from the current limit of 1 GB to 1.99 GB: 

1. Connect to the Studio Enterprise 3.1 server machine. 
2. Go to the directory: C:\Program Files\Bluebeam Software\Studio\API. 
3. Open the Web.config file in that directory using a text editor running with Administrator privileges. 

4. Locate the following block of XML within the Web.config file: 
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                                                  Max Request Length & Content Length 

<system.web> 
    <compilation targetFramework="4.5" /> 
    <httpRuntime targetFramework="4.5" maxRequestLength="2097151" /> 
</system.web> 
<system.webServer> 
    <security> 
        <requestFiltering> 
            <requestLimits maxAllowedContentLength="2147483647" /> 
        </requestFiltering> 
    </security> 
</system.webServer> 

5. The current values of the maxRequestLength and maxAllowedContentLength can be changed to the values 
shown above. 
WARNING:  These are the only values that should be modified within this file. Modifying any other values may 
cause significant/unforeseen problems. 

6. Save the changes. 
7. Restart the Bluebeam Studio Server IIS Site. 

  
At this point, you will be able to upload up to 1.99 GB files to Studio Projects.  
 
Note: If a file does not exceed the file limit and still fails to upload, it may be timing out. If it takes 90 seconds or more to 
transfer it may be timing out. To address this issue, ensure file transfer speeds are adequate.  
 
 

Bluebeam Server (Services) Fail to Restart 
 
Problem 
The Bluebeam Services (Bluebeam Studio Job Queue & Bluebeam Studio Services) are failing to start. They may move 
into a starting state, but never move to a running state.   
 
Solution 

• Attempt to restart the Bluebeam Services by going to the Bluebeam Studio Enterprise Administrator > Tools > 
Restart Server. 

o If it fails, try a few more times. It sometimes takes 2-3 tries to successfully restart. 
• Make sure the license/trial is still valid and not expired. Restart the services. 
• Check to make sure the Certificate used is still valid.  

o From the Studio Enterprise Administrator, go to Certificate Configuration > Change Certificate and 
select the current certificate for the server, then restart the services. 

▪ Do you receive “Could not find certificate that matches the Certificate Hash." If so, the 
certificate may need to be updated or follow the steps in the Studio Sessions Markups are Not 
Updating in Real Time section of this document. 

o Note: The server's certificate needs to be installed under Personal Certificates (NOT Trusted Root) as this 
is the Digital ID for the server. 

• Ensure that the IIS web site Binding is configured to use the correct certificate. More information on this can be 
found in the Certificate Change section of this document.  

• If it continues to fail, check the Studio Log Files and Event Viewer for errors and additional information.  
o While normally benign, the following error may prevent your server from restarting: [Server Thread] 

WARN Bluebeam.Studio.Collaboration.CServer - Could not find preferred IP address 0.0.0.0, will use first 
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available IP. 
o In this case ensure an IP Addressed is assigned in the Port 443 binding for the Bluebeam Studio Server 

site in IIS. Perform an IISRESET after this change. 
• Ensure Services are set to auto-restart. This process can be found in the Studio Server Trial Expired Error in Revu 

When Trying to Login section. 
 

 

“Unable Reading Settings.XML” error when opening Bluebeam Studio Administrator on 
Studio Enterprise Server 
 
Problem 
Receiving “Unable Reading Settings.XML” error when opening Bluebeam Studio Administrator on Studio Enterprise 
Server. Users may be unable to connect from Revu. 

 
 
 
Solution 

• Check the Windows Event Viewer for errors.  
o We have seen SQL exceptions indicating that the password for the Service Account had expired. 

Updating the password resolved the issue. 
• May be an invalid value set in the T_Configuration Table. 

o If there have been any changes made to this table, roll back changes. 
• If there is a backup of a valid Settings.xml file, make a copy of the current Settings.xml and replace it with the 

backup. The Settings.xml file located C:\ProgramData\Bluebeam Software\Studio on the Studio Enterprise 
server.  

• If all else fails, this can be resolved by reinstalling Studio Enterprise. 
o Note: If the Performance Patch has been implemented, a Settings.xml file with the updated Max Pool 

Size set to 1024 is needed. As well as updated API files uploaded to C:\Program Files\Bluebeam 
Software\Studio\API.  

 

IIS Worker Process Using All (or most) of the CPU 
 
Problem 
The IIS Worker Process is using all (or most) of the CPU. 
 
Solution 
Windows Update may have a required reboot pending. Reboot server and ensure updates are completed.  
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Users Cannot Create Sessions and/or Cannot Create Projects 
 
Problem 
Users are unable to create Studio Sessions and/or Project in the Studio Enterprise environment. 
 
Solution 

• Based upon this behavior, I would first verify the Users properties and the Server Permissions Page within the 
Studio Enterprise portal site.  

o Check the Users section in the web portal. Search for a user who is experiencing this behavior. Ensure 
they have Server Access set to Allowed, as without this they will be unable to access the Studio 
Enterprise Server at all with Restricted access. The Create Session or Create Project settings will both 
keep the user from creating the respective object. If the user needs that function, ensure it is set to 
Allowed and Update profile is selected. The below image shows a user that cannot create Sessions but 
can create Projects. 

  
o More information on these levels of denying access being applied to new users can be found in the 

Studio Enterprise Installation & Configuration Guide. 

• If the Revu Clients are 2016 or older, they may be unable to create Sessions due to the TLS version enabled. If 
this is the case, reference the TLS Issue – Unable to Connect Using Revu 2016 and Older section of this 
document. 

• Check Studio Enterprise Administrator > Status > and verify if there is an IP address in the Hostname field. 
o If so, change this to servers FQDN. You will need to restart the server for change to take effect.  

• Verify if the BluebeamCache database exists on the SQL server. 
 
 
 
 
 

https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
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Add SE Server To All Users – RevuPreferences.xml 
 
There is a way, using the Bluebeam Administrator command line options, to deploy a modified RevuPreferences.xml file 
that will merge only the server settings to the users. This way all other preferences are preserved.  
 
To do so, you should first open the RevuPreferences.xml file in a text editor and add Merge=”True” to the beginning of 
the file, before staging it for deployment. 
 
Here’s what the header should look like: 
 
<RevuPreferenceDictionary Version="1" Merge="True"> 
 
After you have done this we recommend that you delete all the other settings that you do not want to change. So, it 
would look something like this:  
 

<?xml version="1.0" encoding="utf-8"?> 

<RevuPreferenceDictionary Version="1" Merge="True"> 

  <Studio> 

    <Force.Proxy>False</Force.Proxy> 

    

<ServerCache>{"Servers":[{"ServerURL":"studio.bluebeam.com","ServerEmail":"","ServerPassword":"","ServerUserName":"","RequestedAuthMode":0},{"ServerURL":"StudioEnterpr

ise.example.local","ServerEmail":"","ServerPassword":"","ServerUserName":"","RequestedAuthMode":0}],"Active":{"ServerURL":"studio.bluebeam.com","ServerEmail":"","ServerP

assword":"","ServerUserName":"","RequestedAuthMode":0}}</ServerCache> 

    <ShowAgreementScreen>False</ShowAgreementScreen> 

    <Toolbar.Integration.Only>False</Toolbar.Integration.Only> 

    <URL>studio.bluebeam.com</URL> 

  </Studio> 

</RevuPreferenceDictionary> 

 
Please find the Bluebeam Administrator Command Line Options by opening Bluebeam Administrator on a PC with Revu 
> Help > Command Line Options. You would want to use the Pbmngr5.exe /Setup /PrefsPath option in this case.  
Example: "%ProgramFiles%\Bluebeam Software\Bluebeam Revu\[Year]\Pushbutton PDF\PbMngr5.exe" /setup 
/PREFSPATH:”[Path]\RevuPreferences.xml” 
 
Note: Any sections specified in the merged xml file will overwrite what is currently present. For example if a user has 
studio.bluebeam.com and server1.company.local present and the merge file only has a new server 
(server2.company.local) specified, the user will only have the new server after the merge. If other servers are needed, 
they will need to be specified in the merge preferences file. 
 
You can also force the users to use certain Studio Servers. This will disable the Manage Servers dialog box in 
Preferences. More information on this can be found in the following Server Whitelist section of this document. 
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Server Whitelist – Force Allowed Studio Servers 
 
Problem 
If using RevuPreferences.xml to set the default Studio server to your Studio Enterprise server, users may have their User 
overwritten with a default copy that reverts it back to the regular Studio Server. This could happen as a result of a reset 
settings.  
 
Solution  
You can use a registry change to force users to only use certain Studio Servers. As long as you are on version 2015.1+ 
you can use the Studio Whitelist registry key: 
 
1. Open the Registry  
2. Right click on HKLM\Software\Bluebeam Software\Revu > New > Key > Name it 'Studio'  
3. Right click on Studio > New > String Value > Name it ‘AllowedServers’  
4. Right click on it > Modify > Add the desired server name  
5. Close and reopen Revu 2015.1+ 
 
When configured, users will not be able to add/delete under the Manage Servers section of Studio which should keep 
this server locked in for you.  
 
You can find more information on this and forcing Windows Authentication Mode in the following support site article: 
https://support.bluebeam.com/articles/studio-whitelist-control-server-access-and-force-windows-authentication/ 
 

User Not Receiving Session Alerts or Seeing Markups 
 
Problem 
Session users are not seeing new markups or receiving alerts. 
 
Solution 
Ensure the Microsoft Message Queuing (MSMQ) service is running. If Messaging Queueing has crashed, users will not be 
alerted or able to see markups. If you wish to set the MSMQ service to auto recover, reference the  Studio Server Trial 
Expired Error in Revu When Trying to Login section. 
 

Migrating Studio Enterprise Data to Studio Cloud 
 
We unfortunately do not have a backend process to migrate Studio Enterprise (SE) Sessions and Projects to Studio 
Cloud. At this moment this process is manual. Here is what we recommend as our Standard Operating Procedure. 
 
Note: If you wish to know more about our Studio Cloud offerings, please reach out to Sales at sales@bluebeam.com or 
your Account Manager. 
 
Sessions 
• Finish all current Sessions on SE, saving the files as needed. 
• Start new Sessions in Cloud. 
Note: When you upload a document into a new Session, the markups on the document at that time will become locked. 
Due to this you will be unable to migrate Sessions on SE to one on the Cloud unless you no longer need to modify those 
markups. This is why we recommend finishing out all current Sessions in SE and only starting new Sessions on the Cloud. 
 
Projects 

https://support.bluebeam.com/articles/studio-whitelist-control-server-access-and-force-windows-authentication/
mailto:sales@bluebeam.com
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• Download copy of existing Projects on SE. 
• When in the Project you can right-click on the root and press Download Copy.  

• Create new Projects in Cloud. 
• Upload copy of Project into Cloud. 

• If you are only archiving this data and you will not be uploading it to Studio Cloud, you can of course skip 
the last two steps. 

Note: If you are downloading very large Projects and run into issues with the download process, you may need download 
the Project in smaller chunks. Rather than downloading the root of the Project you may want to download the folders 
below the root level. If you check the Project Settings, you can see the Project Size on the General tab. If the Project is 
larger than 50GB you may want to break the download into smaller chunks. 
 
We have also put together some helpful queries that may help in the transition: 
ReportActiveProjects.txt - This is used to report all active Projects, so you can verify what Projects need to be migrated. 
They can use the Portal to see what Sessions are active. 
ReportActiveSessions.txt - This is used to report all active Sessions, so you can verify what Sessions need to be migrated.  
You can also use the Portal to see what Sessions are active. 
Unrestrict Projects.txt - This can change a Project from Restricted to Unrestricted. This way they can now get into a 
Project that was Restricted to download files. 
DisableCreateSessionProjects.txt - This will disable users ability to create Projects/Sessions. There are comments in the 
script to help them apply it to all users or restrict access to the SE server as a whole. This is a good script to run after 
everything has been moved to the cloud and you wish users to start using that instead. 
 
Download Link for scripts: https://studio.bluebeam.com/share/dgjnby 

Password: SEsupport123 
 

Does Studio Enterprise support SAML Authentication? 
No, it does not. Studio Enterprise 3.1 supports LDAP connections for single sign-on. 
 

Two Factor Authentication (2FA) 

 
Studio Enterprise does not support 2FA (two factor authentication), only Windows Authentication with LDAP. 
 

Encryption 
 
As far as encryption goes, document encryption is done between the Revu client and the Studio Enterprise Web Server 
over SSL/TLS using port 443 while in transit. Documents are not encrypted in the users local Studio cache on their local 
machine. 
 
By default, documents are not encrypted in the SQL database; all docs live in the DB as binary blobs. It is possible to 
enable encryption at the SQL Server level. This is not related to Bluebeam though, but instead specific to SQL server. A 
skilled DBA will need to be involved if you chose to enable this.  More information on SQL Server Encryption can be 
found via Microsoft SQL Documentation. 
 

Customizing Templates 
 
If you log into your Studio Enterprise portal (by entering your Studio server name into a web browser) and click "E-mail 
Templates" on the left, you will see all of the different Templates listed on the right. If you click on one of them, you will 
see that you can customize them using HTML. While you can edit them individually, there is not a way to disable one 

https://studio.bluebeam.com/share/dgjnby
https://docs.microsoft.com/en-us/sql/relational-databases/security/encryption/sql-server-encryption?view=sql-server-ver15
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and keep the rest enabled.  
 
If you wish to disable all email notification you can do so. In the Studio Enterprise Administrator application, choosing E-
mailer Service on the left, and then unchecking the "Enable E-mail Notifications" box at the bottom.  
 

Session Archiving/Deletion/Purging 
 
Here are the Session Manager Service & Job Queue Service default values, as detailed in the Studio Enterprise 
Installation and Configuration Guide.  

 
 
If you have these values set, then Sessions that have no activity for 90 days will be moved from an Active state into 
an Archived state. That Session will then be in an Archived state for 180 days before it is moved into a Deleted state. 
When a Session is manually Finished in Revu it will also be moved into a Deleted state. Sessions in 
an Archived or Deleted state are still recoverable by the Session host or Studio Administrator by logging into Studio Web 
Portal, clicking on the Session owner’s account, then My Sessions, and finally double-clicking the Session to recover and 
set the Status value to Active. 
 
When Sessions are in a Deleted state, that is when the "Days to Retain Deleted Sessions" value on the Job Queue Service 
page come into effect. Using the values present above, Sessions in a Deleted state will be held for 30 days before being 
Purged. Once a Session is Purged, it is no longer recoverable. When Sessions meet the criteria, all Sessions will be 
purged when the check is made (Check Every value).  
 
The "Days to Retain Deleted Sessions" value in the Job Queue Service page also applies to documents in Sessions that 
have been deleted. For example, if a document has been deleted from a Session, but the Session is still in an Active or 
Archived state, that document will still be purged as a result of the Job Queue policy. If a document is deleted from an 
active Session, and the Days to Retain value is 30 days, that document will be purged after 30 days even though the 
Session is active. 
 
 
 
 
 
 

https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
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Project Purging 
 
Enable Projects Data Purge - Controls whether or not deleted Projects are eventually purged. 
Purge deleted Projects - Specifies when Projects are purged after deletion. 
Purge deleted Project items – Controls when files and folders are purged after their parent Project has been deleted. 
 
Enable Projects File Revision Management - Determines whether or not file revisions are retained. 
Maintain a maximum of – Sets the maximum number of retained file revisions. 
Note: Versions older than the maximum are automatically purged, and some actions – such as moving or “undeleting” 
files – are tracked in their revision histories, but don’t count as revisions. 
 
The Project Data Purge Service setting is disabled by default. 
 
Note: Be sure that your SQL server has sufficient hard drive space to hold all of your Studio Projects. 
 
When the standard Project purge service is active, it will delete 100 Project items every hour. It is not constantly purging 
in the background. If the purge service is off and is re-enabled, it is not going to perform a big purge operation. Sessions 
use a different process where it will Purge ALL deleted Sessions that match Criteria. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

SQL Server Issues 
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Database Install Fails 
 
Problem 
Database creation fails during Studio Enterprise installation. 
 
Solution 

• Check permissions on Setup account. Ensure the Service Account has the needed permissions. 
o dbcreator – to create and configure the database 
o securityadmin (during creation only) – to configure the Service Account to run stored procedures and 

gain access to the database 
o serveradmin  
o DatabaseMailUserRole 
o Ensure Service Accounts are members of Local Administrator group. 
o More information can be found in the SE Install and Configuration Guide. 

• Check Install Logs.   
o C:\Users\[account]\AppData\Local\Temp – Look for logs starting with “Bluebeam_Studio_”. 
o If there are errors related to “Failed to verify signature of payload” and “Failed authenticode 

verification of payload” > Check certificate and ensure it is trusted. 
• If installing to a new database to SQL 2016, reference the following section Manual Database Install Steps - SQL 

2016.  
 

Manual Database Install Steps - SQL 2016 
 
Currently when you perform a direct install from the 3.1 SE installer to SQL 2016 it will fail if there is no database already 
present. This would not be the case if migrating the database from SQL 2012 to SQL 2016, as the database that is 
migrated over would be present. If there is need for a new database install on SQL 2016, this can be done by manually 
creating the databases in SQL 2016 using scripts. After the databases are created the installer can then be ran and 
pointed to the SQL server. Here are the steps to perform this operation: 
 
Download Link for Database Install Scripts: https://studio.bluebeam.com/share/3yxkae 
Password: SEsupport123 
 

1. Make sure SQL CMD mode is enabled: 
a. On the SSMS, go to the Tools menu, select Options. 
b. Expand the Query Execution tab, and select SQL Server, click the General page. 
c. Check the box By default open new queries in SQLCMD Mode. 

https://support.bluebeam.com/articles/studio-enterprise-installation-configuration-guide/
https://studio.bluebeam.com/share/3yxkae
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2. Edit the scripts and change the DefaultDataPath and DefaultLogPath variables in both scripts to whatever is applicable 
for your SQL Server configuration. 

a. In Object Explorer, right-click on your server and click Properties. 
b. In the left panel on that Properties page, click the Database settings tab. 
c. In Database default locations, view the current default locations for new data files and new log files. 

3. Run the BluebeamCache script first, followed by the BluebeamStudio script. 
4. After both scripts are run, change compatibility mode. 

a. Right-click the database and select Properties. 
b. Select the Options page and set Compatibility level to SQL Server 2012 (110). 

 
5. The Studio Enterprise installer is now ready to be ran and pointed to the new SQL server 
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SQL Server Migration 
 
In migrating to a new SQL Server, your Database Administrator will need to be involved and guiding most of the process. 
Your DBA will be able to perform most of the migration in line with what their regular process is, though there are some 
general best practices and recommendations. 
 
Please see SQL database migration and installation: Guidance and best practices for the recommended steps to migrate 
your Studio Enterprise SQL server to SQL 2016. 
 

SQL Queries 

Check Fragmentation Script  
It’s best to keep fragmentation below 15% if possible. This script can help verify the fragmentation on important 
indexes. With that information you can then change the maintenance routine as needed.  
 

--This query will return fragmentation values for Bluebeam Studio Indexes 
USE BluebeamStudio 
GO 
 
SELECT dbtables.[name] as 'Table', 
dbindexes.[name] as 'Index', dbindexes.type_desc, 
indexstats.avg_fragmentation_in_percent 
FROM sys.dm_db_index_physical_stats (DB_ID(), NULL, NULL, NULL, NULL) AS indexstats 
INNER JOIN sys.tables dbtables on dbtables.[object_id] = indexstats.[object_id] 
INNER JOIN sys.schemas dbschemas on dbtables.[schema_id] = dbschemas.[schema_id] 
INNER JOIN sys.indexes AS dbindexes ON dbindexes.[object_id] = indexstats.[object_id] 
AND indexstats.index_id = dbindexes.index_id 
WHERE indexstats.database_id = DB_ID() 

 

Active Connections Script 
The Studio Server (Web Server) has the max pool connection size set to 100 by default. This query will return all active 
connection values for the database. If this query shows at/or above 100 for the ".Net SQLClient Data Provider" row, 
then the Studio Enterprise Performance Patch may be needed.  
 

--This query will return active connection values for Bluebeam Studio 
USE BluebeamStudio 
GO 
SELECT 
getdate() [date], 
s.host_name, 
s.program_name, 
s.login_name, 
COUNT(s.session_id) 
FROM sys.dm_exec_sessions s 
INNER JOIN sys.dm_exec_connections c 
ON s.session_id = C.session_id 
WHERE s.is_user_process = 1 
group by s.program_name, s.login_name, s.host_name 
ORDER BY COUNT(s.session_id) DESC 

 
Note: This is a real-time query that should be ran during peak usage hours or during times where there are performance 
issues being reported by end users. 
 

https://support.bluebeam.com/articles/sql-db-guidance-best-practices/
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Reset Studio Credentials Script 
Reference the Reset Studio Enterprise to Studio Credentials Only section for more context on why you may need to run 
this script.  
 

--This SQL script will delete all AD Integration Configurations and set it back to Studio 
Credentials Only mode 
USE BluebeamStudio 
GO 
DELETE FROM T_ActiveDirectoryUser 
DELETE FROM T_DomainGroup 
DELETE FROM T_DomainConfiguration 
UPDATE T_Configuration 
SET VALUE = 'StudioCredentialsOnly' 
WHERE NAME = 'AuthenticationMode' 

 

WARNING:  The above SQL changes have the possibility of causing data loss or DB corruption.  An experienced DBA 
should be involved for any of these changes. Backups should be made of the DB, prior to any changes. 
 

Return Session Status Script 
The following query can return the Session Status for you. Use this if you wish to verify the Sessions status with more 
precision than found in the Session Status and Properties Panel – Portal section. 
 

--Find Session Status 
USE BluebeamStudio 
GO 
SELECT PublicID, Name, Created, LastConnected, Status, Deleted 
FROM T_Session 
WHERE PublicID = 'xxx-xxx-xxx'; --ENTER Session ID  

 
The Session Status Values: 
0 = Active 
1 = Suspended 
2 = Archived 
3 = Finalizing  
4 = Deleted 
5 = Purged 
 

Return User Role Information Script 
The following Query will return the user information, as well as the roles and ServerAccess value to see if they are 
Suspended. If needed you can use the SELECT function to add additional columns. If you run this script, there will be a 
separate entry for each different role.  
 

--Return User Role Information 
USE BluebeamStudio 
GO 
SELECT T_User.UserID, T_UserRole.RoleID, T_User.Email, T_User.DefaultName, 
T_User.ServerAccess, T_User.Created 
FROM T_User 
LEFT JOIN T_UserRole 
ON T_User.UserID = T_UserRole.UserID; 
 

Role Legend 
1 = Administrator 
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2 = User (Deprecated – Not Used) 
3 = Technician 
4 = Service 
Null - Traditional access (Note: Null is the default Standard User value if no other user option is selected) 
 
Server Access Legend  - Reference User Administration and Reporting section for more information on Suspended value. 
0 = Suspended (Server Access set to Restricted) 
1 = Active (Server Access set to Allowed) 
 

Revu Client Issues 
 

Clearing Revu Client Session Cache 
 
There are several circumstances in which a user’s Session Cache may become corrupted and needs to be cleared. Below 
are steps on how to accomplish this. 
 
First, within Revu, let's go into the Session in question > Down towards the bottom there is a Pending Tab > Do you have 
any markups showing here? If you do, make sure your internet connection is online so that we can get these uploaded.  
 

 
 

If the Pending Tab is empty, we then want to log out of Studio and go to the following path on your computer: 
Session Cache: 
%localappdata%\Bluebeam\Sessions (v2017) 
%localappdata%\Revu\2018\Sessions (v2018) 
%localappdata%\Revu\data\Sessions (v2019 and above) 
 
Once you are here, go into the folder that bears the Studio Enterprise server name (if your Session is currently in 
studio.bluebeam.com then you’ll want to go to that folder) > From here, rename the folder that shows the Session ID in 
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question (You can place OLD at the end) > Relaunch Revu > Log back into Studio > Go back into the Session in question 
and see if the issue is resolved. 
 
Note: Once you log back into the Session, this cached folder is recreated with the data from the Session hosted on the 
Studio Server. 
  

Clearing Revu Client Project Cache 

 
There are several circumstances in which a user’s Project Cache may become corrupted and needs to be cleared. Below 
are steps on how to accomplish this. 
 
First, within Revu, let’s go into the Project in question and confirm that you do not have any files currently checked out. 
 

 
 
Once this is confirmed, log out of Studio and go to the following path on your computer: 
%localappdata%\Bluebeam (If using Revu 2015-2017) 
%localappdata%\Revu (If using Revu 2018) 
%localappdata%\Revu\data\ (If using Revu 2019 and above) 
 
Once you are here, you need to find a folder named the same as the Project ID (xxx-xxx-xxx). As it is on a Studio 
Enterprise Server, the location is not standard. I would search this location for a folder of that name or go into each "0X" 
folder until you find it. Rename the folder that shows the Project ID in question (You can place OLD at the end) > Within 
Revu, log back into Studio > Go back into the Project in question and see if the issue is resolved. 
 
Note: Once you log back into the Project, this cached folder is recreated with the data from the Project hosted on the 
Studio Server 
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 “Unable to establish a secure connection” error when logging in  
 
Problem 
When attempting to login to Studio Enterprise through Vu or Revu, users receive an error stating “Unable to establish a 
secure connection to “YourStudioURL”.  

 
 
Solution 
Please use the following article to resolve issue:  https://support.bluebeam.com/articles/unable-to-establish-secure-
connection-error/ 
 

Trouble Logging in (User) 
 
Problem 
User unable to successfully log in to Studio Enterprise (SE) server in Revu client. 
 
Solution 

• Confirm that the Studio Enterprise server name is correct without any typos. 

• If your company uses Active Directory to connect to SE, then make sure that your domain\email is correct. If 
they don't use Active Directory, then you'll want to only enter your email address associated with your Studio 
account. 

• If you still cannot get in, check the "Use Windows Authentication" box and try logging in that way. 

• Try logging into Studio Enterprise server via a browser:  
a. Example: https://bluebeam.company.com 
b. If they are able to login here, this will help validate if the user’s credentials are correct. 

• Check Revu Client logs on the user’s machine, look for errors in the revu.log. 

• If you are still not having any luck, you will want to have an admin check the Studio Portal to ensure the users 
Studio account is set up properly on the back end.  

a. More information on this can be found in the User Administration and Reporting section. 

• The users accounts password may need to be reset.  
a. More information on this can be found in the Reset Password section. 

 

Login Error: Could not reach “YourStudioURL” at this time. Would you like to work offline?  
 
Problem 
When attempting to login to Studio Enterprise through Vu or Revu, users receive an error stating, could not reach 
“YourStudioURL” at this time. Would you like to work offline?” 

https://support.bluebeam.com/articles/unable-to-establish-secure-connection-error/
https://support.bluebeam.com/articles/unable-to-establish-secure-connection-error/
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Solution 
Please use the following article to resolve issue:   https://support.bluebeam.com/articles/login-error-could-not-reach-
yourstudiourl-at-this-time/ 
 

Unable to Modify Session/Project Permissions, Fails to Upload Markups in Sessions 
 
Problem 
In Revu 2015 and older you may be unable to modify Session/Project Permissions. It may also fail to upload markups in 
Sessions. 
 
Solution 

• Upgrade users to newer version of Revu supported by Studio Enerprise. 

• Disable WebDAV on the server as this is interfering with the calls Revu makes to communicate with Studio. 
Disabling the feature through server manager is recommended, only edit web.config if server requires WebDAV 
for another reason. More information on this process can be found in the Unknown Error in Revu when 
applying permissions or attendee access settings in Revu section of this document. 

 

Can't Finalize Session 
 
Problem 
Unable to Finalize a Session.  
 
Solution 

• If the user is running Revu 2015, update to the latest version (2015.6) or update to newer version. 
• Check the logs for the end users Revu Client. 
• Have the Session or Project owner ensure the end user has the needed permissions to perform action. 
• Can the user Save As or generate a Session Report? 
• Test process on a different user’s system to verify if issue is related to this specific Revu instance. 
• Clear local Session cache (backup folders if there are changes that haven't been uploaded) and try again. 
• Test with a different Studio Account to verify if it is related to the Account. 
• Check Event Viewer & Studio Logs on Studio Enterprise Server. 

 

Can't Upload or Download Files to or from Sessions/Projects 
 
Problem 
End user is unable to upload or download files to or from a Project and/or a Session. 
 
Solution 

https://support.bluebeam.com/articles/login-error-could-not-reach-yourstudiourl-at-this-time/
https://support.bluebeam.com/articles/login-error-could-not-reach-yourstudiourl-at-this-time/
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• Check the logs for the end users Revu Client. 
• Test process on a different user’s system to verify if issue is related to this specific Revu instance. 
• Clear local Session/Project cache (backup folders if there are changes that haven't been uploaded) and try 

again. 
• Test with a different Studio Account to verify if it is related to the Account. 
• Have the Session or Project owner ensure the end user has the needed permissions to perform action.  
• Check Event Viewer & Studio Logs on Studio Enterprise Server. 
• Verify if the Studio Enterprise server or the SQL server is out of disk space. 

o Ensure the Database is not full and is set to auto-expand. 
 

Can’t Go Offline with Studio Enterprise 
 
Problem 
Users are unable to go into Offline mode while using Studio Enterprise. 
 
Solution 
This could be case-sensitivity issue with email address. 

1. Ensure there are no pending Session markups, or they will be lost. Close Revu. 
2. Open the following location in File Explorer: %appdata%\Bluebeam Software\Revu\[year] 
3. Rename UserSettings.xml file. 
4. Reset settings in Revu. 

• Instructions on how to reset settings will change depending on Revu version. Look here for steps. 

• The reset settings option in Revu resets your settings to their original configurations. Before proceeding, it’s 
recommended to back up your settings in case this reset doesn’t produced the desired result. 

5. Reopen Revu and login to Studio again. 
 

Error: “A validated e-mail address is required to login…” 
 
Problem 
The following message appears when trying to log into a Studio Project or Session: 
“A validated e-mail address is required to login. A new validation e-mail has been sent.” 
 
Solution 
Please reference the following Support Site Article: https://support.bluebeam.com/articles/error-a-validated-e-mail-
address-is-required-to-login/ 
 

Session Files in Studio Enterprise Fail to Download with Revu 2017.0.20 
 
Problem 
Users in organizations running Bluebeam Studio Enterprise are unable to download files from Studio Sessions with Revu 
2017.0.20. 
 
Solution 
Studio Session documents may not download successfully when using Revu/Vu version 2017.0.20 on Studio Enterprise. 
To resolve this issue update Revu to 2017.0.40 or 2018-2019. This issue is specific to 2017.0.20. 
 
Please use the following article to resolve issue:  https://support.bluebeam.com/articles/session-files-in-studio-
enterprise-fail-to-download-with-revu-2017-0-20/ 
 

https://support.bluebeam.com/articles/how-to-back-up-your-revu-2019-settings-stamps/
https://support.bluebeam.com/articles/error-a-validated-e-mail-address-is-required-to-login/
https://support.bluebeam.com/articles/error-a-validated-e-mail-address-is-required-to-login/
https://support.bluebeam.com/articles/session-files-in-studio-enterprise-fail-to-download-with-revu-2017-0-20/
https://support.bluebeam.com/articles/session-files-in-studio-enterprise-fail-to-download-with-revu-2017-0-20/
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Update Project Copy 
 
In order to see the "Update Project Copy" option when right clicking a Session file that was created from a Project, the  
user must be the Host of the Project in question. Otherwise the option will not be present. 

 

Time Stamp Difference 
 
When working in Sessions/Projects you may see different time stamps, that may be confusing if there are users 
throughout different time zones. This is related to the time zone that the end users Revu client is running. So, if I user is 
in California for example, they will be using their time zone and a user in New York will be using their own. Whatever 
you have your time zone set to, you will see the adjusted time in relation to that zone. If the user in New York places a 
markup and the user in California looks at the time stamp directly after it is places, they will see that it was placed 
seconds ago, in their time zone. If the person who created the report did so from the CST time zone, all the time stamps 
will be based off that time zone. 
 
In relation to the time stamps found in the Studio Portal, these will be based on the Time Zone in which the Studio 
Enterprise server is using. 
 

How To’s 

Adding a Studio Enterprise Server to Revu 
 
Within Revu's Studio Tab, click the drop-down arrow next Studio > Click Sign In… > select Manage Servers OR open 
Preferences (Alt+P) > select the Studio page on the left > select the Servers tab. From here select the “+” icon > add the 
Studio Enterprise Hostname > press OK. 
 

 
 

Creating User Accounts 
 
Within Revu's Studio Tab, click the drop-down arrow next Studio > Click Sign In… > Select the Studio Enterprise Server in 
question > Click the "Create Account" link in the bottom left hand corner > Once you have entered your email, 
password, and confirmed your password, click OK. This should allow you to create an account on their server now.  
 
Please reference the following Support Site Article for further info: https://support.bluebeam.com/articles/how-do-i-
create-a-bluebeam-studio-account-in-revu-or-vu 

https://support.bluebeam.com/articles/how-do-i-create-a-bluebeam-studio-account-in-revu-or-vu
https://support.bluebeam.com/articles/how-do-i-create-a-bluebeam-studio-account-in-revu-or-vu
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Change Email Address Associated with SE Account 
 
You can change your email address by entering your company's Studio Enterprise server into a browser:  
Example: https://bluebeam.company.com 
 
Sign in using your Studio account login information > In the My Profile section, click the Change Email tab > Update your 
email address and confirm your password.  
 

Change Display (Default) name 
 
You can change your Default Name by entering your company's Studio Enterprise server into a browser:  
Example: https://bluebeam.company.com 
 
Sign in using your Studio account login information > Click My Profile on the left-hand side > Under the User Data Tab, 
you can change your Default Name > Click the Update Profile button once you are done. 
 
Note: The new Default Name will NOT appear in any of your existing Studio Sessions or Projects for integrity's sake. 
However, the Default Name will appear in any new Sessions or Projects you join. 
 

Reset/Change Studio Account Password 
 
If you are attempting to reset the password for a Studio Enterprise account, you can go to the Studio Panel in Revu > 
drop down the Studio Selection > Sign In... > Select Studio Enterprise server. Enter only your email address and press the 
Lost Password button. You should then receive a password reset email. 
 
You can also change your Studio accounts password by entering your company's Studio Enterprise server into a browser:  
Example: https://bluebeam.company.com 
 
Sign in using your Studio account login information > In the My Profile section, click the Change Password tab > Update 
your password and click Change. If you are not seeing the Change Password tab you are likely using an AD account. The 
Change Password Tab Missing from Studio Portal for Some Users section in this document has further details.  
 
If that does not help, do you have AD integration with your SE server?  If you do, try to login both with checking the 
Windows Authentication box and without. You can also try typing your "domain\username". If you still experience issues 
logging in, you may need to reset your AD account password. 
 

Restoring Sessions 
 
For Sessions that have not been purged from the database, it is possible to restore the Session in most cases. This can be 
done by logging into the Studio portal by entering your company's Studio Enterprise server into a browser:  
Example: https://bluebeam.company.com 
 
Sign in using your Studio account login information. If you are the host of the Session, you can then follow these steps: 
Click "My Sessions" on the left side > Click the desired Session that you want to bring back > Change the Status drop 
down from Deleted to Active > Click the "Update data" button > Now you can go back to Revu to log out and log back in 
to Studio > The Session should now appear in your list again. 
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If you are not the host of the Session. a user with Administrator privileges in the Studio Portal can restore the Session via 
the Session tab in the portal.  
 
More information on these processes can be found at the following support site article: 
https://support.bluebeam.com/articles/how-to-reactivate-a-finalized-or-deleted-studio-session/ 
 

Incompatible Features 
 

Incompatible Feature – Not Joined tab for Sessions and Projects 
 
The Not Joined feature introduced with the initial release of Revu 20 is not compatible with Studio Enterprise. Revu will 
behave the same as it did in previous versions, where you only have access to the Joined list of Sessions/Projects. The 
Not Joined tab, as seen below, will not be visible when connected to Studio Enterprise.  
 

 

Incompatible Feature – Reassign Session Markup Ownership 
 
The Revu 20.1 feature, that allows you to securely reassign markup ownership when a collaborator permanently leaves 
a Session is not compatible with Studio Enterprise. Instead, Revu will be behave as it did in previous versions. When you 
select Deny for an attendee, the below pop up window will not appear. 
 

 
 

https://support.bluebeam.com/articles/how-to-reactivate-a-finalized-or-deleted-studio-session/
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Incompatible Feature - Flatten when creating Share Link to Project File 
 
If you select the Share Link... option for a Project file in Studio Enterprise, there will be no Flatten option. If you wish to 
share a flattened PDF from a Project, you will need to manually run a Flatten (Ctrl+Shift+M) operation on it first. 
 

 
 

Incompatible Feature - Major/Minor Version selection when Checking In Project Files  

 
The ability to select if the changes to a file are Major or Minor version changes when checking in a Project file is not 
possible with Studio Enterprise.  
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Incompatible Feature - Update Project Copy from Session  
 
The ability to update a Project Copy from a file that is checked out to a Session is not possible in Studio Enterprise. If the 
Project Copy needs to be updated, you will need to Finish the Session > Overwrite Existing Files > and then Check the 
files back in.  
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